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はじめに 

BI という言葉が最初に使われたのは 1959 年の刊行物1（IBM Journal vol.2）で「産業、科学、また

は政府機関のさまざまな部門に情報を広めるための自動システムが…」という説明と共にでてきます。

現代でも IBM 社からは BI 関連製品が出荷され、AI（による分析）を活用した BI を謳っています。

Microsoft 社も BI を名前の一部に冠した製品を出していますが、こちらは会話型のデータ視覚化ツー

ルという位置づけです。日本では BI という言葉自体に馴染みが薄く、「分析...何を？」という感じで

すがコードレスの視覚化ツールとして利用できる場面は多いと思います。特に定型的な帳票出力に使

う場合はシステムと会話する必要もありません。 

帳票のファイル形式には作成ツールの独自形式のものもありますが、多くの場合 PDF（ISO 32000）

が選択できます。PDF はスクリプトで編集・出力するためのライブラリも作られています（Python 

ReportLab 他）が、BI ツールを使うと複雑な様式の帳票も定義体を作って管理することができます。 

1. Report ツール 

紙媒体から電子媒体に変化しても一定の期間保存を義務付けられている会計帳簿、社外取引文書の

ようなものがあるので帳票イメージの作成ツールが製品としていくつも市場にでています。帳票ツー

ルを扱うとき、デザイン（レイアウトや固定出力部分の設定）とビューア（データの埋め込みと表示）

の２つの要素があるのでこの組み合わせを考える必要があります。例えば、少量・簡易なレイアウト

であれば Web ブラウザにデータを表示して印刷や PDF 化を利用者に任せる。あるいは、SVG を

Illustrator 等のソフトで作成してブラウザのスクリプトでデータを埋め込む方法等があります。 

BIに分類される帳票ツールを使う利点は帳票のデザインとビューアがセットで構成されていること

と、データソースを関係づけられることでデータに纏わる制御が要らなくなり、定型の帳票を人手を

介さずに作成することができるようになります。ここではオープンソースで企業色が薄く商用利用も

可能な Eclipse BIRT(Business Intelligence and Reporting Tools、Eclipse Public License 2.0…以下

BIRT)を紹介します。 

2. BIRT のインストール 

BIRT の帳票デザイナは Java の開発等に使う Eclipse IDE（以下、Eclipse）のプラグインです。 

ビューアは構成の形態が幾つかありますが、Webアプリが必要で少量のコード実装が必要になる場

合があります。使った（個別にインストールした）ツールは以下のものです。 

➀ JDK 11  

➁ Spring Tools Suite (STS) 4.16.1.RELEASE（Spring を含まない Eclipse でもレポート作成は可能） 

➂ Eclipse BIRT Designer  4.10.0 

 

 

 

1 ビジネスインテリジェンスシステム https://ieeexplore.ieee.org/document/5392644 

https://ieeexplore.ieee.org/document/5392644
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2.1. Spring Tools Suite (STS) 

STS は Eclipse に Spring のプラグインを格納したものです。Spring Framework を使うと Web の認

証機能等、ライブラリを使った機能追加が比較的簡単にできます。 

Spring の公式サイト https://spring.io/tools からダウンロードする以外にも以下のいずれかの方法

で STS を構成することができます。 

・Pleiades のサイト https://mergedoc.osdn.jp/ から（日本語化もされている）ダウンロードする 

・Help メニューの「Eclipse マーケットプレース」から「Spring Tool Suite」を追加する 

2.2. BIRT プラグイン 

Help → Install New Software... 

 

 

 

 

 

 

 

 

リポジトリ（インストール元サイト）追加…Location に次の URL（Name は適宜）を登録します 

https://download.eclipse.org/birt/update-site/latest/ 

 

 

 

 

 

 

追加ソフトの選択…全てにチェックを入れて、Next ボタンを押下します 

 

 

 

 

 

 

 

 

 

 

https://spring.io/tools
https://mergedoc.osdn.jp/
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「ライセンス条項に同意する」をチェックし、Finish ボタンを押下します 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

終盤で証明書が付属していない資材を信頼するか確認がでます。 

⇒ 画面上段の Type 欄をチェック Trust Selected ボタンを押下⇒Restart Now で再起動すると完了 

 

 

 

クリックすると進行

状況が表示されま
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3. レポートフォーマットの作成（BIRT デザイナ） 

（１）レポートプロジェクトの作成 

初期状態の Project Explore で Create Project か、メニュー File → New → Project...から進みます 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

（２）新規レポートの作成 

レポートプロジェクトを右クリックし、New → レポート を選びます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Next ボタン押下で 

テンプレートが選択できます  ⇒ 
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作成したレポートの「マスターページ」タブで用紙設定 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. 開発環境でのデータベース接続 

データベースと接続するための環境は帳票開発時（プレビュー）と稼働時で異なり、以下の説明は

プレビューで帳票にデータベースのデータを載せるための設定です。 

4.1. JDBC データソース 

JDBC ドライバを用意2して STS(Eclipse)から参照できる場所に保存します。 

データエクスプローラからレポート毎に使うデータを設定します。新規レポートを作成すると「デ

ータソース」が表示されるので右クリックし、新規データソースを選びます。 

※ データソース等はレポートを削除すると同時に消えます（レポート間のコピー／貼り付けは可能） 

 

 

 

 

 

 

 

 

  

 

 

2 サンプルで使った RDBMS は SQLite で、ドライバは以下サイトの sqlite-jdbc-<バージョン>.jar 

https://github.com/xerial/sqlite-jdbc/releases  

https://github.com/xerial/sqlite-jdbc/releases


BI‐Report（Eclipse BIRT, Spring boot） 

Copyright(C)2022 Future Office Coordinate Service Corporation All Rights Reserved.   p. 6 

新規データソースの登録 

 

 

 

 

 

 

 

 

 

 

 

 

JDBC Data Source を選び、Next ボタン押下⇒ 

 

 

 

 

 

 

 

 

 

 

 

 

4.2. データセットの登録 

データセットを右クリックし、データセットの新規作成を行います。 

 

 

 

 

 

 

 

 

 

 

➀初めて使うドライバは

「ドライバの管理」から登

録する 

➁追加ボタンでドライバ

の場所を指定する 

追加したドライバが選べるようになる 

データベースの URL を指定後、 

接続テストで「接続完了」がでたら OK 
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データセットの新規作成 

※ クエリもレポートを削除すると消えます。必要であればテキストで保存してください 

※ クエリは全角の空白が含まれないよう注意してください 

 

 

 

 

 

 

 

 

 

 

 

データセット名を入力し Next 押下  ⇒ 

 

 

 

 

 

 

 

 

 

 

 

4.3. レポートの編集 

（１）グラフ 

グラフを含めレポートに配置する要素は Palette のアイコンをレポートにドラッグして追加でき

ます。テンプレートからのグラフは、グラフのアイコンをダブルクリックして種類を決めます 

 

 

 

 

 

 

 

 

クエリテキストを入力して、Finish 押下 
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【折れ線グラフ】 

 

 

線を描く系列を作成し、 

 

 

 

項目を追加 

 

 

 

 

 

 

 

 

   x 軸の項目を指定 → 

 

「フィルタ」からデータの選別条件を設定 

 

 

 

 

 

 

＜グラフの書式設定タブ＞  

v 系列 – タイトルでグラフ線の凡例を設定 

 

 

 

 

 

 

 

  

グラフが表示幅に入らない場合、自動的に

要素が集約されます。グループ化しないと、

全体が 1 要素に集約される場合があります 
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（２）テーブル 

データをリスト形式で表示したい場合は、テーブルを Palett からドラッグします。複数行／明細

にしたり１セルに複数項目設定することが可能です。表示するデータはデータセットで定義した項

目、固定文字列、計算や文字列操作した結果等を表中に埋め込むことができます。 

テーブルは HTML に似て、配置（右揃え、左揃え...）や罫線、背景色、幅等の各種の属性は階

層的に持っています。例えば表上にテキストボックスを配置して文字列を右寄せで出力する場合、

テキストボックスと表のセルの両方の書式が右揃えになっていないと希望通りに表示されません。 

 

 

 

 

 

 

 

 

＜出力＞デフォルトのままでフッタ出力や改ページも行われます。 

 

 

 

 

 

 

 

 

 

 

4.4. 開発中の確認（PDF 作成の例） 

メニュー Run → レポートの表示(R)  
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＜全体の出力例＞ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

（2 頁以降は省略） 



BI‐Report（Eclipse BIRT, Spring boot） 

Copyright(C)2022 Future Office Coordinate Service Corporation All Rights Reserved.   p. 11 

5. レポートの作成（BIRT ビューア） 

デザインしたレポート（拡張子 .rptdesign）からは html や PDF が作成できます。運用時の作成の

方法は BIRT ビューアを Web アプリとして起動するか、BIRT ランタイムをコマンドで起動します。 

5.1. バッチ起動によるレポート作成 

Eclipse のダウンロードサイト3から birt-runtime-<バージョン>.zip を取得し、zip ファイルを解凍

して ReportEngine ディレクトリに入っている genReport.bat(Linux は genReport.sh)を実行します。 

（１）実行環境 

コマンド実行時に JDBC ドライバが JAVA クラスパスから参照できる必要があります。簡単な方

法としては ReportEngine\lib に JDBC ドライバを含む jar ファイルを格納してください。 

その他、Java 11 と BIRT 4.10 の組合せで正常に動作しています。 

（２）コマンド実行 

C:\Users\User>< birt-runtime のパス>\ReportEngine\genReport.bat <レポート定義の格納パス>report.rptdesign 

※ デフォルトは HTML で出力されます。PDF はオプションに -f pdf を指定してください 

※デフォルトの出力先はレポート定義の格納パスです。-o オプションで出力先を変更できます 

5.2. Web アプリ（WebViewerExample） 

Eclipse のダウンロードサイトにある birt-runtime-<バージョン>.zip には、バッチ起動ツールの

ReportEngine とは別に Web アプリの WebViewerExample フォルダが入っています。このフォルダを

アプリサーバに配備します。以下、オープンソースの Apache Tomcat 上で動作させる例です。 

5.2.1. アプリサーバの準備 

Tomcat はサポートする仕様や利用する Java バージョンの組合せでサポート中のバージョン4が複

数ありますが、現役でサポートされているバージョンであればどれでも構いません。以下は

apache-tomcat-9.0.69 を C:\Tools に設置し、コマンドプロンプトで起動させる例です。 

➀ ダウンロードサイトより 64-bit Windows zip を取得します 

➁ 取得した zip ファイルを C:\Tools\ apache-tomcat-9.0.69 ディレクトリに解凍します 

➂ 以下のコードを書いたサーバ起動用バッチファイル（拡張子 .bat）を作ります 

a.コードページを UTF-8に変更 

b. 環境変数 CATALINA_HOME設定 

c. 環境変数 JAVA＿HOME設定 

d. 起動スクリプト実行 

e. スクリプト実行後ウィンドを残す 

※WindowsTerminal 等、コマンドプロンプト以外のツールから起動する場合は文字コードに関わ

 

 

3  Eclipse Downloads https://download.eclipse.org/birt/downloads/drops/latest/ 

4 Apache Tomcat Versions https://tomcat.apache.org/whichversion.html 

chcp 65001 

set CATALINA_HOME=C:\Tools\apache-tomcat-9.0.69 

set JAVA_HOME=C:\Tools\AdoptOpenJDK\jdk-11.0.10.9-hotspot 

call C:\Tools\apache-tomcat-9.0.69\bin\startup.bat 

cmd /k 

https://download.eclipse.org/birt/downloads/drops/latest/
https://tomcat.apache.org/whichversion.html
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る変更は不要になる場合があります 

【サーバ起動用バッチファイルの内容】 

a. Tomcat は UTF-8 の文字コードで出力するので、コマンドプロンプトを合わせます 

b. c. Tomcat は起動時に以下の環境変数の設定が必要です 

・CTALINA_HOME：Tomcat のインストール先。bin,conf,lib,webapps 等の親ディレクトリ 

・JAVA_HOME ：JDK のインストール先。bin,conf,lib 等の親ディレクトリ 

➃ アプリサーバのログ出力を UTF-8 から SJIS に変更します。 

【変更資材／箇所】変更前の資材はコピー＆リネームで必ずバックアップを取ってください 

資材：C:\Tools\apache-tomcat-9.0.69\conf\logging.properties 

 

 

 

 

 

 

 

 

※ Tomcat の起動スクリプトは startup.bat ⇒ catalina.bat ⇒ java /Tomcat の起動と進み、サーバ

起動用バッチファイルとは別のプロセスになるためコードページの切り替えが効きません。 

5.2.2. BIRT ビューアの配備 

birt-runtime-<バージョン>.zip に含まれている WebViewerExample を 

C:\Tools\apache-tomcat-9.0.69\webapps に格納します。このとき webapps 内のディレクトリ名

が Web アプリ名になるので、分かり易くかつ使い易い名前に変更します。 

 

 

 

 

 

 

 

 

 

 

 

 

ディレクトリ名は 

WebViewerExample

から 

birt 

に変更しました 
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● BIRT ビューアの初期画面表示 

サーバ起動用バッチファイルを起動すると別画面が開いて birt の Web アプリケーション配備が

完了したことと、サーバが起動した旨のログが出力されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

サーバの起動が表示されたらブラウザで http://localhost:8080/birt を開きます。 

 

 

 

 

 

 

 

 

 

 

一番下のリンク View Example をクリックして以下のサンプル画面が表示されたら完成です。 

 

 

 

 

 

 

 

 

 

 

http://localhost:8080/birt
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5.2.3. 新規作成したレポートの追加 

BIRT デザイナで作成したレポート（拡張子.rptdesign）のファイルを webapps/birt ディレクトﾘ

に格納し、index.jsp にリンクを作ります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

（１）index.jsp の改修点 

 

 

 

 

 

 

➀ 原状だと日本語が表示できないので page ディレクティブで文字コード utf-8 を指定します。 

<%@ page language="java" contentType="text/html; charset=utf-8" pageEncoding="utf-8"%> 

➁ 新しいレポートを表示するためのリンクを追加します。 

【追加例】 

<p><a href="<%= request.getContextPath( ) 

 + "/frameset?__report=new_report.rptdesign&__format=pdf" %>">Covid19 近況</a> 

【パラメータの内容】 

__report : BIRT デザイナーで作成したレポートのファイル名 

__format: html（デフォルト）または pdf を指定します   

index.jsp に追加したレポート

のリンクを作成 

作成したレポートのコピーを格納 

（推奨は report フォルダ配下） 
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（２）JDBC ドライバの追加 

新規レポートの JDBC データソースで使ったドライバをクラスパスに配置します。汎用的に使う

のであれば tomcatの lib（webappsと並列のディレクトリ）、レポート固有で使うのであれば以下の

場所に jar ファイルを格納して Tomcat を再起動します。 

（Windows のパス表記）webapps\birt\WEB-INF\lib 

5.2.4. アプリサーバ（Tomcat）の再起動 

以上の操作を行った後に Tomcat の停止スクリプトを実行し、もう一度サーバ起動バッチファイル

を実行します。 

（停止スクリプト）C:\Tools\apache-tomcat-9.0.69\bin\shutdown.bat 

5.2.5. 新規レポートの表示 

サーバを再起動後にブラウザで http://localhost:8080/birt を開くと以下のように表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

index.jsp に追加したリンクを

クリックすると、パラメータで指定

したレポートが表示されます 

http://localhost:8080/birt
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6. セキュリティの追加 

前項のように birt-runtime に同梱されているWebViewerExample のサーブレットで自作のレポート

を作成することができますが、このままでは不特定多数のネットワーク接続に対して情報を開示して

しまいます。営業秘密や部内限り等の扱いは利用者の識別・認証やアクセス制御が必要になります。 

6.1. Web アプリの構成 

BIRT は継続的にバージョンアップされてきて今後の予定も出ています。BIRT ビューアも簡単に

置き換えができ、レポートの追加や更新がし易いように構成する例をあげます。 

・ビューアのオリジナル部分を改変しない（できればフォルダごと入替える） 

・ビューアに直接リクエストを出さず、認証とアクセス制御（簡易なもの）を挟むようにする 

【画面構成】 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

一般ユーザ 

BIRT ビューア 

（レポート定義体以外は既存のまま） 

 

新
た
に
作
る
部
分 
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6.2. STS を使ったプロジェクトの作成 

Spring Boot を使い、Tomcat に認証を行うアプリと BIRT ビューアの二つの Web アプリを配備し

た実行形式の jar にします（BIRT ビューアは jar の起動中に動的に配備します）。以下の操作は全て

STS で行います。 

6.2.1. Web アプリ開発用の Java 設定 

STS 4.16 は JDK を同梱しておりデフォルトでは Java17 のコンパイラが使われます。これ以外、特

に下位バージョンの実行環境では動作しない場合があるので目的の実行環境に合わせておきます。 

（以下、日本語化していない STS を使い Java11 環境用の設定をする例） 

（１） JRE 

メニューの Window → Preferences から Java > Installed JREs   Add...ボタンで別途インストール済

の JDK を追加し、デフォルトに設定します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

（２）コンパイラー 

前項と同じく Java > Compiler  の Compiler compliance level:を 11 にします。 
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6.2.2. 新規プロジェクト 

Package Explorer を右クリックし、New → Spring Starter Project を選択します。 

 

 

 

 

 

 

 

 

 

 

  

 

 ・Name: birt 

 （プロジェクト名：適宜変更可） 

 ・Type:  Maven 

 ・Java Version: 11 

 ・その他の項目適宜 

 （意味が解らない場合はそのまま） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Next> で以下のライブラリを選択 

 ▶Security > Spring Securithy 

 ▶Template Engines >Thymeleaf 

 ▶Web >Spring Web 

 Finish ボタン押下  

2.x.x を選択。2022/11/24 に

3.0.x がリリースされていますが、そ

ちらは Java17 以上が必要です 
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【pom.xml】 

プロジェクトの作成で作られるファイルです。 

但し 44 行目～60 行目は Spring Starter Project で取り込めないため手作業で追加した行です。

<?xml version="1.0" encoding="UTF-8"?> 1 
<project xmlns="http://maven.apache.org/POM/4.0.0" 2 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 3 
 xsi:schemaLocation="http://maven.apache.org/POM/4.0.0 https://maven.apache.org/xsd/maven-4.0.0.xsd"> 4 
 <modelVersion>4.0.0</modelVersion> 5 
 <parent> 6 
  <groupId>org.springframework.boot</groupId> 7 
  <artifactId>spring-boot-starter-parent</artifactId> 8 
  <version>2.7.6</version> 9 
  <relativePath/> <!-- lookup parent from repository --> 10 
 </parent> 11 
 <groupId>com.example</groupId> 12 
 <artifactId>birt</artifactId> 13 
 <version>0.0.1-SNAPSHOT</version> 14 
 <name>birt</name> 15 
 <description>BIRT project with Spring Boot</description> 16 
 <properties> 17 
  <java.version>11</java.version> 18 
 </properties> 19 
 <dependencies> 20 
  <dependency> 21 
   <groupId>org.springframework.boot</groupId> 22 
   <artifactId>spring-boot-starter-thymeleaf</artifactId> 23 
  </dependency> 24 
  <dependency> 25 
   <groupId>org.springframework.boot</groupId> 26 
   <artifactId>spring-boot-starter-web</artifactId> 27 
  </dependency> 28 
  <dependency> 29 
   <groupId>org.springframework.boot</groupId> 30 
   <artifactId>spring-boot-starter-security</artifactId> 31 
  </dependency> 32 
  <dependency> 33 
   <groupId>org.springframework.security</groupId> 34 
   <artifactId>spring-security-test</artifactId> 35 
   <scope>test</scope> 36 
  </dependency> 37 
  <dependency> 38 
   <groupId>org.springframework.boot</groupId> 39 
   <artifactId>spring-boot-starter-test</artifactId> 40 
   <scope>test</scope> 41 
  </dependency> 42 
   43 
  <!-- 以下、Spring Securityとthymeleafを組み合わせて使うための設定 Start --> 44 
     <dependency> 45 
   <groupId>org.thymeleaf.extras</groupId> 46 
   <artifactId>thymeleaf-extras-springsecurity5</artifactId> 47 
  </dependency> 48 
  <!-- Spring Securityとthymeleafを組み合わせて使うための設定 End --> 49 
 50 
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  <!-- 以下、Spring Bootの組み込みTomcatでJSPを使うための設定 Start --> 51 
  <dependency> 52 
   <groupId>org.apache.tomcat.embed</groupId> 53 
   <artifactId>tomcat-embed-jasper</artifactId> 54 
  </dependency> 55 
  <dependency> 56 
   <groupId>javax.servlet</groupId> 57 
   <artifactId>jstl</artifactId> 58 
  </dependency> 59 
  <!-- Spring Bootの組み込みTomcatでJSPを使うための設定 End --> 60 
 </dependencies> 61 
 62 
 <build> 63 
  <plugins> 64 
   <plugin> 65 
    <groupId>org.springframework.boot</groupId> 66 
    <artifactId>spring-boot-maven-plugin</artifactId> 67 
   </plugin> 68 
  </plugins> 69 
 </build> 70 
 71 
</project> 72 
 

※pom.xml は Maven が参照／更新しますが、手作業で更新すると保存時に STS が必要なライブラリ

のダウンロードを行います 

6.2.3. 作成する資材 

 

src/main/java/ 

 com.example.login パッケージ：以下の構成用 Java 

 ①AppConfig…BIET ビューアの配備とログ出力先 

 ❷BirtApplication…main（自動生成のまま） 

 ③MvcConfig…リクエストと表示 html の紐付け 

 ④WebSecurityConfig…Spring Security 認証関連 

src/main/resources 

 template フォルダ：thymeleaf タグを使う html 

 ①login…認証画面 

 ②report…利用者の役割に応じたレポートを表示 

 Application.properties：birtWeb アプリ配備元 path 

src/test/java 

 BirtApplicationTest…自動生成されたテストクラス 

※src/main/java/の BirtApplication とパッケージ名

を一致させておかないとビルドの工程でエラーが発

生します  
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src/main/java/com.example.login 

①【AppConfig.java】クラス名に関係無く＠Configuration により Spring がこのクラスを処理します 

package com.example.login; 1 
/* 2 
 * BIRT ビューア（webapps)を Spring Boot の環境に取り込むための環境設定 3 
 */ 4 
import java.io.File; 5 
 6 
import org.apache.catalina.Context; 7 
import org.apache.catalina.startup.Tomcat; 8 
import org.springframework.beans.factory.annotation.Value; 9 
import org.springframework.boot.autoconfigure.condition.ConditionalOnProperty; 10 
import org.springframework.boot.web.embedded.tomcat.TomcatServletWebServerFactory; 11 
import org.springframework.boot.web.embedded.tomcat.TomcatWebServer; 12 
import org.springframework.context.annotation.Bean; 13 
import org.springframework.context.annotation.Configuration; 14 
 15 
@Configuration 16 
public class AppConfig { 17 
 18 
 @Bean 19 
 @ConditionalOnProperty(name = "external.webapp.dir") //application.properties に external.webapp があ20 

ったら以下のメソッドを使う 21 
 public TomcatServletWebServerFactory servletContainerFactory( 22 
            @Value("${external.webapp.dir}") String path, 23 
            @Value("${external.webapp.context}") String contextPath 24 
            ) { 25 
     return new TomcatServletWebServerFactory() { 26 
 27 
         @Override 28 
         protected TomcatWebServer getTomcatWebServer(Tomcat tomcat) { 29 
          //Springboot からだと org.apache.commons.discovery.DiscoveryException が発生する 30 
          //対策としてシステムプロパティで LogFactory を割り当てます。 31 
          System.setProperty("org.apache.commons.logging.LogFactory", 32 

"org.apache.commons.logging.impl.LogFactoryImpl"); 33 
 34 
          logger.info("-------------------------------------------------"); 35 
          logger.info("configuring app with basedir: " + new File(path).getAbsolutePath()); 36 
 37 
          Context ctx = tomcat.addWebapp(contextPath, new File(path).getAbsolutePath()); 38 
          ctx.setParentClassLoader(getClass().getClassLoader()); 39 
 40 
             logger.info("Context : " + ctx.toString()); 41 
          logger.info("-------------------------------------------------"); 42 
 43 
             return super.getTomcatWebServer(tomcat); 44 
         } 45 
 46 
     }; 47 
 }48 
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②【BirtApplication.java】自動生成のまま

package com.example.login; 1 
 2 
import org.springframework.boot.SpringApplication; 3 
import org.springframework.boot.autoconfigure.SpringBootApplication; 4 
 5 
@SpringBootApplication 6 
public class BirtApplication { 7 
 8 
 public static void main(String[] args) { 9 
  SpringApplication.run(BirtApplication.class, args); 10 
 } 11 
 12 
} 13 

③【MvcConfig.java】

package com.example.login; 1 
 2 
import org.springframework.context.annotation.Configuration; 3 
import org.springframework.web.servlet.config.annotation.ViewControllerRegistry; 4 
import org.springframework.web.servlet.config.annotation.WebMvcConfigurer; 5 
 6 
@Configuration 7 
public class MvcConfig implements WebMvcConfigurer { 8 
 9 
 public void addViewControllers(ViewControllerRegistry registry) { 10 
  registry.addViewController("/").setViewName("login"); 11 
  registry.addViewController("/login").setViewName("login"); 12 
  registry.addViewController("/report").setViewName("report"); 13 
 } 14 
} 15 

④【WebSecurityConfig.java】

package com.example.login; 1 
 2 
import org.springframework.context.annotation.Bean; 3 
import org.springframework.context.annotation.Configuration; 4 
import org.springframework.security.config.annotation.web.builders.HttpSecurity; 5 
import org.springframework.security.config.annotation.web.configuration.EnableWebSecurity; 6 
import org.springframework.security.core.userdetails.User; 7 
import org.springframework.security.core.userdetails.UserDetails; 8 
import org.springframework.security.core.userdetails.UserDetailsService; 9 
import org.springframework.security.provisioning.InMemoryUserDetailsManager; 10 
import org.springframework.security.web.SecurityFilterChain; 11 
 12 
@Configuration 13 
@EnableWebSecurity 14 
public class WebSecurityConfig { 15 
 16 
 @Bean 17 
 public SecurityFilterChain securityFilterChain(HttpSecurity http) throws Exception { 18 
  http 19 
   .authorizeHttpRequests((requests) -> requests 20 
    .antMatchers("/").permitAll() //ルートの URL パスだけ認証無のリクエストを許す 21 
    .anyRequest().authenticated() 22 
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   ) 23 
   .formLogin((form) -> form 24 
    .loginPage("/login") 25 
                .defaultSuccessUrl("/report", true) 26 
    .permitAll() 27 
   ) 28 
   .logout((logout) -> logout.permitAll()); 29 
 30 
  return http.build(); 31 
 } 32 
 33 
 @Bean 34 
 public UserDetailsService userDetailsService() { 35 
  UserDetails user = 36 
    User.withDefaultPasswordEncoder() //デモ専用の簡易実装です。（詳細は Spring 公式… 37 
    .username("user") 38 
    .password("password") 39 
    .roles("USER") 40 
    .build(); 41 
  UserDetails user2 = 42 
    User.withDefaultPasswordEncoder() //デモ専用の簡易実装です。（詳細は Spring 公式… 43 
    .username("user2") 44 
    .password("password") 45 
    .roles("ADMIN", "USER") 46 
    .build(); 47 
 48 
  return new InMemoryUserDetailsManager(user, user2); 49 
 } 50 
} 51 

src/main/resources/templates 

①【login.html】 

<!DOCTYPE html> 1 
<html xmlns="http://www.w3.org/1999/xhtml" xmlns:th="https://www.thymeleaf.org" 2 
      xmlns:sec="https://www.thymeleaf.org/thymeleaf-extras-springsecurity5"> 3 
    <head> 4 
        <title>BIRT レポート出力 利用者確認 </title> 5 
    </head> 6 
    <body> 7 
        <div th:if="${param.error}"> 8 
            利用者 ID か password が無効です. 9 
        </div> 10 
        <div th:if="${param.logout}"> 11 
            ログアウトしました. 12 
        </div> 13 
        <form th:action="@{/login}" method="post"> 14 
            <div><label> 利用者 ID : <input type="text" name="username"/> </label></div> 15 
            <div><label> Password: <input type="password" name="password"/> </label></div> 16 
            <div><input type="submit" value="Sign In"/></div> 17 
        </form> 18 
    </body> 19 
</html> 20 
 21 



BI‐Report（Eclipse BIRT, Spring boot） 

Copyright(C)2022 Future Office Coordinate Service Corporation All Rights Reserved.   p. 24 

②【report.html】 

<!DOCTYPE html> 1 
<html xmlns="http://www.w3.org/1999/xhtml" xmlns:th="https://www.thymeleaf.org" 2 
      xmlns:sec="https://www.thymeleaf.org/thymeleaf-extras-springsecurity5"> 3 
    <head> 4 
        <title>レポート</title> 5 
    </head> 6 
    <body> 7 
        <h1 th:inline="text">出力可能なレポート by 8 

[[${#httpServletRequest.remoteUser}]]</h1> 9 
  <span sec:authentication="principal.authorities"></span> 10 
   11 
  <div sec:authorize="hasRole('ADMIN')"> 12 
   <p><a href=birtviewer/frameset?__report=report/new_report.rptdesign&__format=pdf>Covid19 近況</a></p> 13 
        </div> 14 
  <div sec:authorize="hasRole('USER')"> 15 
   <p><a href=birtviewer/frameset?__report=test.rptdesign&__format=html>一般ユーザ向けレポート</a></p> 16 
   <p><a href=birtviewer/frameset?__report=test1.rptdesign&__format=html>一般ユーザ向けレポート（続報）17 

</a></p> 18 
        </div> 19 
         20 
        <form th:action="@{/logout}" method="post"> 21 
            <input type="submit" value="Sign Out"/> 22 
        </form> 23 
    </body> 24 
</html> 25 

src/main/resources/ 

【application.properties】 

#埋込 Tomcat のログ出力先（デフォルト）･･･C:\Users\利用者ＩＤ\AppData\Local\Temp\tomcat.8080.n-数字 18 桁1 
-n 2 
server.tomcat.accesslog.enabled=true 3 
 4 
external.webapp.dir=/C:/Users/User/Desktop/birtviewer 5 
external.webapp.context=/birtviewer 6 

※application.properties の 4 行目は WEB-INF、webcontent ディレクトリの上の階層を指定（起

動後もこのディレクトリの資材が参照されます）。他の資材は上記コード例のままで動作します 

6.2.4. STS からの起動 

pom.xmlと application.propertiesを修正し、その他の資材をコピーすると STSから起動できます。 

 

 STS 画面左下（初期）Boot Dashboad

からプロジェクト(birt)を選んで起動します 

Console にポート番号 8080 で Tomcat

開始のメッセージがでたら、ブラウザから

localhost:8080 を開いて login します 
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6.3. 実行形式（jar）ファイルの作成 

プロジェクトを選択し、メニュー Run ⇒Run Configurations または 

右クリックで Run as → Maven build... 

Goals を設定して Run ボタンを押下します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※Maven は初期化、依存ライブラリのコピー、パッケージ化の工程を順に実行します。この画面で指

定する Goals は実行する最後の工程を指定するので、以下のコマンドを実行したのと同義になります 

mvn clean dependency:copy-dependencies package 

＜エラー／ワーニング＞ 

● [WARNING]The requested profile "pom.xml" could not be activated because it does not exist. 

が出力されたら、プロジェクトを右クリックして Properties を開き、Maven に書かれている pom.xml

を消します。（このワーニングが出ていてもビルドは正常に終了します） 

 

 

 

 

 

 

 

 

Goals:に package を指定します 

Profiles:意図的に切替をするので

なければ初期値 pom.xml を消す 
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● TESTS 工程で[ERROR]が表示される場合 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mavenが実行するテストは、src/main/javaに@SpringBootApplicationを書いたソースと src/test/java

に@SpringBootTest と書いたソースが対になって存在する前提になっています。 

※具体的な動作は@SpringBootTestのクラスから@SpringBootConfigurationを探してテスト対象を特

定する処理で@SpringBootConfiguration を継承している@SpringBootApplication を見つけます 

したがって、Spring Boot のプロジェクトを作ったときに自動生成された以下の構成が維持されてい

ればこのエラーは発生しません。 

以下の対応関係を壊すパッケージ名やパスの変更した場合は手作業で整合性を合わせてください。 

src/main/java 

com.example.login 

BirtApplication    …@SpringBootApplication 

src/test/java 

com.example.login 

BirtApplicationTests    …@SpringBootTest 

 

●「BUILD SUCCESS」と表示されたら成功です。 

 

（中略） 
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6.4. Jar の実行 

Maven でビルドした Jar ファイルはプロジェクトの target ディレクトリ内に作られます。 

以下のコマンドで実行してください。 

> java -jar <jarファイル名> 

《実行例》 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

終了は ctrl + c     …停止時に「WARNING: An illegal reflective access operation has occurred」

が表示（Tomcat9 と Java11 の組合せで発生 issues#15101）されても、処理に問題はありません 

 

 Tomcat の起動メッセージ出力後、アクセスが可能になります 

Build で作られた jar。これを Java コマンドで実行します。 

birtviewer が参照できれば他に移動しても実行可能です 

（中略） 
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6.5. セキュリティに関する注意点 

（１）利用者管理について 

実装例の認証では WebSecurityConfig に利用者 ID とパスワード、役割等を直書きしていますが

実際の運用では基幹システムの認証に統合するか、管理権限者が運用中に利用者 ID を停止できる

システムが必要です（OpenLDAP や Keycloak 等 Spring で使えるオープンソースもあります）。 

（２）セキュリティレベル 

BIRT のレポートビューアは http リクエストに認証情報を求めないので、レポート名（定義名）

さえ知っていれば curl 等のコマンドを使って誰でもレポートを取得できます。このため情報の重要

度によって以下の対策が必要です。 

➀ レポート定義名をランダムにして推測できなくする（アクセス用の html にだけ帳票名を表示） 

➁ BIRT ビューアの前にリバースプロキシ（サーバ側のプロキシ）を用意して認証する 

➂ 重要な帳票はサーバ／LAN を分けてファイアウォールで要求元を選別する 

以上 


